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5 Slide the paper width guide and adjust it against the stack 
of print material without bending.

Now, the display on the front panel prompts you to confirm 
the paper size in the Multi-Purpose Tray. 

NOTE: Your printer cannot automatically detect the size of paper 
loaded in the Multi-Purpose Tray. Configuring the Multi-Purpose 
Tray with the correct paper size allows you to select paper by size 
rather than paper source when you print from your software 
application. You do not have to check which paper is loaded in the 
Multi-purpose Tray before printing.

6 Press the scroll button (  or ) until the size of paper 
you loaded appears on the bottom line of the display.

7 Press the Enter button ( ). Now, you are ready to print.

8 When you print a document, configure the paper source and 
type in the software application.

For information about setting on the control panel, see 
page 3.5.
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9 After printing, push the extender back to its place and close 
the Multi-Purpose Tray.

Using the Manual Feed Mode

If you select Manual Feed in the Source option when changing 
print settings, you can manually load a sheet of print material in 
the Multi-Purpose Tray. Manually loading paper can be helpful 
when you want to check the print quality after each page is 
printed. 

This loading procedure is almost the same as the procedure for 
loading in the Multi-Purpose Tray, except you load paper 
sheet-by-sheet in the Tray, send print data to print the first 
page, and press the On-Line/Continue button ( ) on the 
control panel to print each following page.

1 Load a sheet of print material on the centre of the 
Multi-Purpose Tray with the print side up. 

2 Slide the paper width guide and adjust it against the 
material without bending.
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3 When you print a document, you must select Manual Feed 
for Source from the software application, and then select 
the correct paper size and type. 

4 Print a document.

The display shows a message prompting you to load paper 
and press the On-Line/Continue button ( ).

5 Press the On-Line/Continue button ( ). 

The printer picks up the paper and prints. After one page is 
printed, the message appears again.

6 Insert the next sheet into the Multi-Purpose Tray and press 

the On-Line/Continue button ( ).

Repeat this step for every page to be printed.
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Printing on Envelopes

1 Open the Multi-Purpose Tray and slide the extender to its 
full-length position.

2 Open the rear output tray and pull the extender.

Guidelines
• Only use envelopes recommended for laser printers. Before 

loading envelopes in the Multi-Purpose Tray, make sure that 
they are undamaged and are not stuck together. 

• Do not feed stamped envelopes.
• Never use envelopes with clasps, snaps, windows, coated 

lining, or self-stick adhesives. These envelopes may severely 
damage the printer.



USING PRINT MATERIALS 4.15

4

3 Flex or fan the edge of the envelope stack to separate the 
pages before loading.

4 Load the envelopes onto the Multi-Purpose Tray with the 
flap side down. 

The stamp area is on the left side and the end of the 
envelope with the stamp area enters the tray first. 

5 Adjust the guide to the edge of the envelope stack.
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6 When you print on envelopes, configure the paper source, 
type and size properly in the software application. For 
details, see page 5.7. 

For details about setting on the control panel, see page 3.5.

7 After printing, close the Multi-Purpose Tray and the rear 
output tray.
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Printing on Labels

1 Open the Multi-Purpose Tray and the rear output tray.

2 Load labels with the print side up. Adjust the guide to fit 
the width of the labels. 

Guidelines
• Only use labels recommended for laser printers.
• Verify that the labels’ adhesive material can tolerate fusing 

temperature of 200°C (392°F) for 0.1 second.
• Make sure that there is no exposed adhesive material 

between the labels. Exposed areas can cause labels to peel 
off during printing, which can cause paper jams. Exposed 
adhesive can also cause damage to printer components.

• Do not feed a sheet of label through the printer more than 
once. The adhesive backing is designed for one pass through 
the printer.

• Do not use labels that are separating from the backing sheet 
or are wrinkled, bubbled, or otherwise damaged.



USING PRINT MATERIALS4.18

3 When you print on labels, configure the paper source, type 
and size properly in the software application. For details, 
see page 5.7. 

For details about setting on the control panel, see page 3.5.

4 After printing, close the Multi-Purpose Tray and the rear 
output tray.

NOTE: To prevent labels from sticking, do not let the printed label 
sheets stack up as they are printed out. 
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Printing on Transparencies

1 Open the Multi-Purpose Tray and the rear output tray.

2 Load transparencies with the print side up, and the top 
with the adhesive strip entering the printer first. 
Adjust the guide to fit the width of the transparencies. 

Guidelines
• Only use transparencies recommended for use in laser 

printers.
• Ensure that transparencies are not wrinkled, curled, or have 

any torn edges.
• Hold the transparencies by the edges and avoid touching the 

print side. Oils deposited on the transparency can cause print 
quality problems.

• Be careful not to scratch or leave fingerprints on the print 
side.
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3 When you print on transparencies, configure the paper 
source, type and size properly in the software application. 
For details, see page 5.7. 

For details about setting on the control panel, see page 3.5.

4 After printing, close the Multi-Purpose Tray and the rear 
output tray.

NOTES: 
• If you print on thin transparencies to the rear output tray, they 

can be curled. In this case, use the top output tray. If the 
problem persists, check if your transparencies meets the 
printer’s specifications.

• To prevent transparencies from sticking, do not let the printed 
sheets stack up as they are printed out.

• Place transparencies on a flat surface after removing them from 
the printer.



USING PRINT MATERIALS 4.21

4

Printing on Preprinted Paper

Preprinted paper is paper that has some type of printing placed 
on it before it is sent through the printer (paper that has a 
preprinted logo at the top of the page, for example).

1 Load letterheads into the tray you want to use, as shown in 
the figures below. Adjust the guides to fit the width of the 
paper stack.

Guidelines
• Letterheads must be printed with heat-resistant ink that will 

not melt, vaporize, or release hazardous emissions when 
subjected to the printer’s fusing temperature of 400 °F 
(205 °C) for 0.1 second.

• Ink on letterheads must be non-flammable and should not 
adversely affect any printer rollers.

• Forms and letterheads should be sealed in a moisture-proof 
wrapping to prevent changes during storage.

• Before you load preprinted paper as forms and letterheads, 
verify that the ink on the paper is dry. During the fusing 
process, wet ink can come off preprinted paper.

Load with the design face 
down, bottom edge 
towards the printer.

Load with the design face 
up, top edge towards the 
printer.
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2 When you print, configure the paper source, type and size 
properly in the software application. For details, see 
page 5.7. 

For details about setting on the control panel, see page 3.5.

Printing on Card Stock or 
Custom-sized Materials

Postcards, 3.5 by 5.83 in. (index) cards and other custom-sized 
materials can be printed with your printer. The minimum size is 
76 by 127 mm (3 by 5 in.) and the maximum size is 216 by 
356 mm (8.5 by 14 in.).

Guidelines
• Always insert the short-edge into the Multi-Purpose Tray first. 

If you want to print in landscape mode, make this selection 
through your software. Inserting paper long-edge first may 
cause a paper jam.

• Do not load more than 10 cards into the Multi-Purpose Tray at 
a time.

• Do not print on media smaller than 76 mm (3 in.) wide or 
127 mm(5 in.) long.

• Set margins at least 6.4 mm (0.25 in.) away from the edges 
of the material in the software application
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1 Open the Multi-Purpose Tray and the rear output tray.

2 Load print material with print side up and short edge first. 
Adjust the guide to fit the width of the material stack.

3 When you print, configure the paper source, type and size 
properly in the software application. For details, see 
page 5.7. 

NOTE: If the size of your print material is not listed in the Size 
box in the Paper tab of the printer driver properties, click the Add 
Custom button and set the size manually. See page 5.7.

CAUTIONS: When you use 76 by 127 mm (3 by 5 in. )paper and it 
is too thin, a paper jam may occur. Use the card stock heavier than 
105g/m2

For details about setting on the control panel, see page 
page 3.5.

4 After printing, close the Multi-Purpose Tray and the rear 
output tray.
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This chapter explains the printing options and common 
printing tasks. 

This chapter includes:

• Printing a Document

• Setting Paper Properties

• Using the Toner Save Mode

• Printing on Both Sides of Paper

• Printing Multiple Pages on One Sheet of Paper 
(N-Up Printing)

• Printing the Reduced or Enlarged Document

• Fitting Your Document to a Selected Paper Size

• Printing Posters

• Printing Booklets

• Using Watermarks

• Using Overlays

• Setting Graphic Properties

• Using Output Options

PRINTING TASKS
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Printing a Document

The following procedure describes the general steps required for 
printing from various Windows applications. The exact steps for 
printing a document may vary depending on the application 
programme you are using. Refer to the User’s Guide of your 
software application for the exact printing procedure.

NOTES: 
• For detailed information about printing from a Macintosh 

computer, see Appendix A, "Using Your Printer with a 
Macintosh."

• For detailed information about printing from a Linux system, 
Appendix C, "Using Your Printer in Linux."

1 Open the document you want to print.

2 Select Print from the File menu. The Print window is 
displayed (It may look slightly different depending on your 
application). 

The basic print settings are selected within the Print 
window. These settings include the number of copies and 
print range.

Make sure that your 
printer is selected.

��Windows 98
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3 To take advantage of the printer features provided by your 
printer, click Properties in the application’s print window 
and go to Step 4. 

If you see Setup, Printer or Options, click that button 
instead. Then click Properties in the next screen.

4 Now you see the Samsung ML-2550 Series Properties 
window, which allows you to access all the information you 
will need when using your printer. 

The Layout tab is first displayed.   

If necessary, select the Orientation option. 

The Orientation option allows you to select the direction in 
which information is printed on a page. 
• Portrait prints across the width of the page, letter style. 
• Landscape prints across the length of the page, 

spreadsheet style. 
• If you want to rotate the page in 180 degrees, select Rotate 

180 Degrees.

The preview image 
shows the sample page 
with the settings you 
currently specified.

��Landscape ��Portrait
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5 From the Paper tab, select the paper source, size and type. 
For further details, see page 5.7. 

6 Click other tabs on the top of the Samsung ML-2550 series 
Properties window to access other features, if needed. 

7 When you complete setting the properties, click OK until 
the Print window is displayed. 

8 Click OK to start printing. 

Notes:
• Most Windows applications will override settings you specify in 

the printer driver. Change all print settings available in the 
software application first, and change any remaining settings 
using the printer driver. 

• The settings you change remain in effect only while you are 
using the current programme. To make your changes 
permanent, make them in the Printers folder. Follows this 
procedure:
1. Click the Windows Start menu.
2. For Windows 95/98/Me/NT 4.0/2000, select Settings and 

then Printers.
For Windows XP, select Printers and Faxes.

3. Select the Samsung ML-2550 Series printer.
4. Click the right mouse button on the printer icon and: 

• In Window 95/98/Me, select Properties.
• In Windows 2000/XP, select Print Setup or select 

Properties and click Printing Preferences.
• In Windows NT 4.0, select Document Default.

5. Change the settings on each tab, and click OK.
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Cancelling a Print Job

There are two ways to cancel a print job.

To stop a print job from the control panel:

Press the Cancel button ( ). 

The printer will finish printing the page that is moving through 
the printer and delete the rest of the print job. Pressing the 
button cancels only the current job in the printer. If more than 
one print job is in the printer memory, the button must be 
pressed once for each job.

To stop a print job from the Printers folder:

1 From the Windows Start menu, select Settings.

2 Select Printers to open the Printers window, and 
double-click the Samsung ML-2550 Series icon. 

3 From the Document menu, select Cancel Printing 
(Windows 9x/Me) or Cancel (Windows NT 4.0/2000/XP).

��Windows 98
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Using a Favorite Setting

The Favorites option, which is visible on each properties tab, 
allows you to save the current properties settings for future use. 

To save a Favorites item:

1 Change the settings as needed on each tab. 

2 Enter a name for the item in the Favorites input box. 

3 Click Save. 

To use a saved setting, just select the item from the Favorites 
drop down list. 

To delete a Favorites item, select it from the list and click 
Delete. 

You can also restore the printer driver’s default settings by 
selecting <Printer Default> from the list. 

Using Help

Your printer has a help screen that can be activated by the Help 
button in the printer’s properties window. These help screens 
give detailed information about the printer features provided by 
the printer driver.

You can also click  from the upper right hand corner, and then 
click on any setting. 
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Setting Paper Properties

Use the following options to set the basic paper handling needs 
when you access the printer properties. See page 5.2 for more 
information about accessing printer properties. 

Click the Paper tab to access various paper properties. 

Property Description

 Copies Copies allows you to choose the number of 
copies to be printed. You can enter up to 999. 

 Size The Size option allows you to choose the size 
of paper loaded in the tray. 

If the required size is not listed in the Size 
box, click Add Custom. When the Custom 
Page Size window appears, set the paper and 
click Ok. The size setting appears in the Size 
list so that you can select it. 

1

2

3

4

5

1

2

Enter the custom 
name you want to 
use. 

Enter the paper 
size. 
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Source Make sure that Source is set to the 
corresponding paper tray.

The Manual Feed source is used when 
printing to special materials. You have to load 
one sheet at a time into the Multi-Purpose 
Tray. See page 4.12.

If the paper source is set to Auto Select, 
the printer automatically picks up print 
materials according to the following order: 
Multi-Purpose Tray, Tray1, Optional Tray2.

Type Make sure that Type is set to Printer 
Default. If you load a different type of print 
materials, select the corresponding paper 
type. For more information on print 
materials, refer to Chapter 4, "Using Print 
Materials." 

If you use cotton paper, set the paper type to 
Thick for the best printing.

To use recycled paper, which weights from 
20lb to 24lb, or other colored paper, select 
Color paper.

First Page
This property allows you to print the first 
page using a different paper type from the 
rest of the document. You can select the 
paper source for the first page. 

For example, load thick stock for the first 
page into the Multi-Purpose Tray, and plain 
paper into the Tray1. Then, select Tray1 in 
the Source option and Multi-purpose 
Tray in the First Page option.

Property Description

3

4

5
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 Using the Toner Save Mode

Toner Save mode allows the printer to use less toner on each 
page. Using this mode will extend the life of your toner cartridge 
and reduce your cost per page, but will reduce the print quality. 
This setting is not available with the 1200 dpi setting. 

There are three ways to enable Toner Save mode:

Using the control panel button

Press the Toner Save button ( ) on the control panel. The 
printer must be in ready mode; the On-Line/Continue button 
( ) is on in green and “Ready” is shown on the display.

• If the button backlight is on, the mode is enabled and the 
printer uses less toner to print a page.

• If the button backlight is off, the mode is disabled and the 
printer prints in normal mode.

Using the control panel menu

You can set the Toner Save item in the Graphics menu to turn 
the Toner Save mode on or off. 

For further details about using the control panel menu, see 
page 3.5.
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From the software application

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2.

2 Click the Graphics tab, and select the Toner Save option. 
You can select from: 

• Printer Setting: If you select this option, the Toner Save 
feature is determined by the setting you’ve made on the 
control panel of the printer.

• On: Select this option to allow the printer to use less 
toner on each page.

• Off: If you don’t need to save toner to print a document, 
select this option. 

3 Click OK.

NOTE: The setting in the software application overrides that on 
the control panel.
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Printing on Both Sides of Paper

You can print on both sides of paper. Before printing, decide on 
which edge you will be binding your finished document. 
The binding options are:

• Long Edge, which is the conventional layout used in book 
binding.

• Short Edge, which is the type often used with calendars. 

NOTE:
• Do not print on both sides of labels, transparencies, envelopes, 

or thick paper. Damage to the printer and paper jamming might 
result.

• To use the double-sided printing, you can use only the following 
paper size: A4, Letter, Legal and Folio.

• Paper jam occurs if duplexing with rear tray open.

There are three ways to enable or disable the double-sided 
printing:

Using the control panel button

Press the Duplex button ( ) on the control panel.

• If the button backlight is on, the printer prints on both sides 
of paper with long edge binding by the default setting.

• If the button backlight is off, the printer prints on one side of 
paper.

Using the control panel menu

You can use the Duplex item in the Layout menu for 
double-sided printing. After setting the item, set the Duplex 
Margin item in the same menu, if necessary.

For further details about using the control panel menu, see 
page 3.5.

��Long Edge ��Short Edge

2 5
3

2

5
3

2

5
3

2 5
3
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From the software application

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2.

2 From the Layout tab, select the paper orientation.

3 From the Duplex(Double-sided Printing) section, select 
the desired binding option.

4 Click the Paper tab and select the paper source, size and 
type.

5 Click OK and print the document.

The printer prints on both sides of paper.

NOTE: The setting in the software application overrides that on 
the control panel.
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Printing Multiple Pages on One
Sheet of Paper (N-Up Printing)

You can select the number of pages to print on a single sheet of 
paper. To print more than one page per sheet, the pages will 
appear decreased in size and arranged on the sheet. You can 
print up to 16 pages on one sheet.

1 To change the print settings from your software application, 
access the printer properties. See page 5.2.

2 From the Layout tab, choose Multiple Pages per Side in 
the Type drop-down list. 

3 Select the number of pages you want to print per sheet 
(1, 2, 4, 9 or 16) in the Pages per Side drop-down list.

4 Select the page order in the Page Order drop-down list, 
if necessary.

Check Print Page Border to print a border around each 
page on the sheet. Print Page Border is enabled only if 
the pages per sheet is 2, 4, 9, or 16.

1 2

3 4

Right, Then 
Down

1

3

2

4

1

2

3

4

2

4

1

3

3

4

1

2
Down, Then 
Right

Left, Then 
Down

Down, Then 
Left
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5 Click the Paper tab and select the paper source, size and 
type.

6 Click OK and print the document. 

Printing the Reduced or Enlarged 
Document

You can scale your print job on a page. 

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2. 

2 From the Layout tab, select Reduce/Enlarge in the Type 
drop-down list. 

3 Enter the desired scaling rate in the Percentage input box. 

You can also click the ��or ❷ button.

4 Click the Paper tab and select the paper source, size and 
type. 

5 Click OK and print the document. 
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Fitting Your Document to a Selected 
Paper Size

This printer feature allows you to scale your print job to any 
selected paper size regardless of the digital document size. This 
can be useful when you want to check fine details on a small 
document. 

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2.

2 From the Layout tab, select Fit to Page in the Type 
drop-down list. 

3 Select the correct size from the Target Paper drop-down 
list.

4 Click the Paper tab and select the paper source, size and 
type.

5 Click OK and print the document. 

A
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Printing Posters

This feature allows you to print a single-page document onto 4, 
9 or 16 sheets of paper, for the purpose of pasting the sheets 
together to form one poster-size document.

1 When you change the print settings from your software 
application, access the printer properties. See page 
page 5.2.

2 From the Layout tab, select Poster in the Type drop-down 
list. 

3 Configure the poster option:

You can select the page layout from 2x2, 3x3 or 4x4. If you 
select 2x2, the output will be automatically stretched to 
cover 4 physical pages. 

��2 x 2 ��3 x 3
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Specify an overlap in millimeters or inches to make it easier 
to reconstruct the resulting poster. 

4 Click the Paper tab and select the paper source, size and 
type.

5 Click OK and print the document. You can complete the 
poster by reconstructing the results. 

Printing Booklets

Booklet printing feature allows you to print your document a 
double-sided job and arrange the pages so that the paper can 
be folded in half after printing to produce a booklet. 

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2.

2 From the Layout tab, choose Booklet Printing in the 
Type drop-down list. 

NOTE: The booklet printing option is available when the A4, 
Letter, Legal or Folio size is selected.

0.1 inches

0.1 inches
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3 Click the Paper tab, and select the paper source, size and 
type.

4 Click OK and print the document.

5 After printing, fold and 
staple the pages. 

Using Watermarks

The Watermark option allows you to print text over an existing 
document. For example, you may want to have large gray letters 
reading “DRAFT” or “CONFIDENTIAL” printed diagonally across 
the first page or all pages of a document. 

There are several predefined watermarks that come with your 
printer, and they can be modified or you can add new ones to 
the list. 

Using an Existing Watermark

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2. 

2 Click the Extras tab, and select the desired watermark in 
the Watermark drop-down list. You will see the selected 
watermark in the preview image. 

3 Click OK and start printing. 

8 9

Preview 
image
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Creating a Watermark

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2. 

2 Click the Extras tab, and click the Edit button in the 
Watermark section. The Edit Watermarks window appears. 

3 Enter the desired text message in the Watermark 
Message box. 

This will be displayed in the preview window. The preview 
image is provided so that you can see how the watermark 
will appear on the printed page.

If the First Page Only box is checked, the watermark will 
be printed on the first page only.

4 Select the desired watermark options. 

You can select the font name, style and size and grayscale 
level from the Font Attributes section and set the angle of 
the watermark from the Message Angle section. 

5 Click Add to add a new watermark to the list. 

6 When you finish editing, click Ok and start printing. 

To stop printing the watermark, select <No Watermark> in the 
Watermark drop-down list. 
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Editing a Watermark

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2. 

2 Click the Extras tab, and click the Edit button in the 
Watermark section. The Edit Watermarks window appears.

3 Select the watermark you want to edit in the Current 
Watermarks list, and change the watermark message and 
the options. Refer to “Creating a Watermark” on page 5.19. 

4 Click Update to save the changes.

5 Click Ok. 

Deleting a Watermark

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2.

2 From the Extras tab, click the Edit button in the 
Watermark section. The Edit Watermarks window appears.

3 Select the watermark you want to delete in the Current 
Watermarks list and click Delete. 

4 Click Ok.
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Using Overlays

What is an Overlay?

An overlay is text and/or images stored in the computer hard 
disk drive (HDD) as a special file format that can be printed on 
any document. Overlays are often used to take the place of 
preprinted forms and letterhead paper. Rather than using 
preprinted letterhead, you can create an overlay containing the 
exact same information that is currently on your letterhead. To 
print a letter with your company’s letterhead, you do not need 
to load preprinted letterhead paper in the printer. You need only 
tell the printer to print the letterhead overlay on your document.

Creating a New Page Overlay

To use a page overlay, you must create a new page overlay 
containing your logo or image.

1 Create or open a document containing text or an image for 
use in a new page overlay. Position the items exactly as you 
wish them to appear when printed as an overlay. If needed, 
save the file for later use.

2 When you change the print settings from your software 
application, access the printer properties. See page 5.2.

3 Click the Extras tab, and click Edit button in the Overlay 
section. 

WORLD BEST

Dear ABC

Regards

WORLD BEST
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4 In the Edit Overlays window, click Create Overlay. 

5 In the Create Overlay window, type a name of up to eight 
characters in the File name box. Select the destination 
path, if necessary. (The default is C:\Formover).

6 Click Save. You will see the name in Overlay List. 

7 Click OK or Yes until you complete creating. 

The file is not printed out. Instead it will be stored on your 
computer HDD disk. 

Note: The overlay document size must be the same as documents 
you will print with the overlay. Do not create an overlay with a 
watermark. 
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Using a Page Overlay

After an overlay has been created, it is ready to be printed with 
your document. To print an overlay with a document:

1 Create or open the document you want to print. 

2 When you change the print settings from your software 
application, access the printer properties. See page 5.2. 

3 Click the Extras tab. 

4 Select the desired overlay from the Overlay drop-down list 
box. 

5 If the desired overlay file does not appear in the Overlay 
list, click the Edit button and Load Overlay, and select the 
overlay file. 

If you have stored the overlay file you want to use into an 
external source, you can also load the file when you access 
this Load Overlay window. 

After you select the file, click Open. The file is now shown 
in the Overlay List box and is available for printing. Select 
the overlay from the Overlay List box. 
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6 If necessary, click Confirm Page Overlay When Printing. 
If this box is checked, a message window will appear each 
time you submit a document for printing, asking you to 
confirm your wish to print an overlay on your document. 

Answering Yes to the window means that the selected 
overlay will be printed with your document. Answering No 
to the window cancels overlay printing. 

If this box is empty and an overlay has been selected, the 
overlay will be automatically printed with your document. 

7 Click OK or Yes until the printing starts. 

The selected overlay will be downloaded with your print job 
and printed on your document. 

Note: The resolution of the overlay document must be the same 
as that of the document you will print with the overlay.  

Deleting a Page Overlay

You can delete page overlays that are no longer used. 

1 In the printer properties window, click the Extras tab. 

2 Click Edit in the Overlay section. 

3 Select the overlay you want to delete from the Overlay 
List box. 

4 Click Delete Overlay. 

5 Click OK until you exit the Print window.
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Setting Graphic Properties

Use the following graphic options to adjust the print quality for 
your specific printing needs. See page 5.2 for more information 
about accessing printer properties.

Click the Graphics tab to display the properties shown below. 

Property Description

Resolution

You can select the printing resolution by 
choosing from 1200 dpi (Best), 
600 dpi (Normal) or 300 dpi (Draft). 
The higher the setting, the sharper the 
clarity of printed characters and graphics. 
Higher settings may increase time it takes 
to print a document. 

Toner Save 

Selecting this option will extend the life of 
your toner cartridge and reduce your cost 
per page without a significant reduction in 
the print quality. For detailed information 
about this mode, see page 5.9.

1

2

3

4

1

2
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Image  
     Mode

Some printed characters or images appear to 
have jagged or uneven edges. Set this 
Image Mode option to improve the print 
quality of your text and image, and make the 
characters and images appear smoother. 

The Image Mode option is only available 
when you select 600 dpi (Normal) in the 
Resolution option.

• Normal: This setting prints images in the 
normal mode. 

• Text Enhance: This setting refines the 
print quality of characters by smoothing 
out jagged edges that can occur on the 
angles and curves of each character. 

• Image Enhance: This setting refines the 
print quality of photo images. 

Advanced
     Options

You can set advanced settings by clicking 
the Advanced Options button. 

Property Description

3

4
Darkness

Use this option to lighten or darken the 
image appearance in your print.

• Normal: This setting is for normal 
documents.

• Light: This setting is for bolder line 
widths or darker gray-scale images.

• Dark: This setting is for finer line width, 
higher definition in graphics, and lighter 
gray-scale images. 

When the Darken Text option is checked, 
all text in your document is allowed to 
print darker than a normal document.
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5

Advanced
     Options 

 

Property Description

4

True-Type Options

This option determines what the driver 
tells the printer about how to image the 
text in your document. Select the 
appropriate setting according to the status 
of your document. 

• Download as Bit Image: When this 
option is selected, the driver will 
download the font data as bitmap 
images. Documents with complicated 
fonts, such as Korean or Chinese, or 
various types of fonts will print faster in 
this setting. 

• Print as Graphics: When this option is 
selected, the driver will download any 
fonts as graphics. When printing 
documents with high graphic content and 
relatively few TrueType fonts, printing 
performance (speed) may be enhanced 
in this setting. 

Print All Text Black

When the Print All Text Black option is 
checked, all text in your document is 
allowed to print solid black, regardless of 
the colour it appears on the screen. When 
it is not checked, coloured text is allowed 
to print in shades of gray.



PRINTING TASKS5.28

Using Output Options

You can use the options for output of your document.

See page 5.2 for more information about accessing printer 
properties.

Click the Extras tab to access the Output Options feature.

Option Description

Print Order

You can set in what sequence the pages will 
be printed. Select the required print order 
from the drop-down list.

• Normal:Your printer prints in normal 
order.

• Reverse All Pages:Your printer prints 
all pages in reversed order. This setting is 
helpful when you are using the rear output 
tray.

• Print Odd Pages:Your printer prints 
only the odd pages of the document.

• Print Even Pages:Your printer prints 
only the even pages of the document.

Reprint When 
Jammed

When this option is checked, the printer 
keeps the image for a printed page until the 
printer signals that the page has 
successfully exited the printer. When a 
paper jam occurs, the printer reprints the 
last page after you clear the jam.
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This chapter provides suggestions for high-quality and 
economical printing and information for maintaining the 
toner cartridge and the printer. 

This chapter includes:

• Printing a Configuration Page

• Maintaining the Toner Cartridge

• Cleaning the Printer

• Consumables and Replacement Parts

MAINTAINING YOUR PRINTER
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Printing a Configuration Page

From the printer’s control panel, you can print a Configuration 
page. Use the configuration page to view current printer 
settings, to help troubleshoot printer problems, or to verify 
installation of optional accessories, such as memory, optional 
tray and printer languages. 

To print a configuration page:

1 Press the Menu button ( ) on the control panel until you 
see “Information” on the bottom line of the display.

2 Press the Enter button ( ) to access the menu.

3 Press the Enter button ( ) when “Configuration” displays 
on the bottom line.

A Configuration page prints out. 
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Maintaining the Toner Cartridge

Toner cartridge storage

To get the maximum results from the toner cartridge, keep the 
following guidelines in mind:

• Do not remove the toner cartridge from its package until 
ready for use. 

• Do not refill the toner cartridge. The printer warranty does 
not cover damage caused by using a refilled cartridge.

• Store toner cartridges in the same environment as the 
printer.

• To prevent damage to the toner cartridge, do not expose it to 
light for more than a few minute.

Toner cartridge life expectancy

The life of the toner cartridge depends on the amount of toner 
that print jobs require. When printing text at 5% coverage, a 
new toner cartridge lasts an average of 10,000 pages. (The 
original toner cartridge supplied with the printer lasts an 
average of 5,000 pages.)

Saving toner

To save toner, press the Toner Save button on the printer 
control panel. The button backlight will be lit. You can also 
enable Toner Save mode in the printer properties or from the 
control panel menu. Refer to “Using the Toner Save Mode” on 
page 5.9 and “Using Control Panel Menus” on page 3.5. 

Selecting this option will extend the life of the toner cartridge 
and reduce your cost per page, but it will reduce the print 
quality. 
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Checking the Toner Remains

You can check the level of toner currently left in the cartridge.

1 Press the Menu button ( ) on the control panel until you 
see “Setup” on the bottom line of the display.

2 Press the Enter button ( ) to access the menu.

3 Press the scroll button (  or ) until “Maintenance” 
displays on the bottom line and press the Enter button 
( ).

4 Press the scroll button (  or ) to select the required 
option, “Remain Toner”.

5 Press the Enter button ( ).

The display shows the percentage of the toner remains.

Redistributing Toner
When the toner cartridge is nearly empty, “Low Toner” appears 
on the display and faded or light areas may appear on a printed 
page. You may be able to temporarily improve the print quality 
by redistributing the toner. 

1 Open the top cover.

2 Remove the toner cartridge from the printer.
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CAUTIONS: 

• Avoid reaching too far into the printer. The fusing area may be 
hot.

• To prevent damage, do not expose the toner cartridge to light for 
more than a few minutes.

3 Gently shake the toner cartridge from side to side 5 for 6 
times to redistribute the toner evenly. 

NOTE: If toner gets on your clothing, wipe it off with a dry cloth 
and wash clothing in cold water. Hot water sets toner into fabric.

4 Reinstall the cartridge and close the cover.

When “Ready  Replace Cart” appears on the display, you need to 
replace the toner cartridge. Refer to the procedures under 
“Replacing the Toner Cartridge” on the next page.
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Replacing the Toner Cartridge

1 Open the top cover.

2 Remove the old cartridge.

3 Install a new toner cartridge. See page 2.4.
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Cleaning the Printer

To maintain the print quality, follow the cleaning procedures 
below each time the toner cartridge is replaced or if print quality 
problems occur.

NOTES: 

• Do not use ammonia-based cleaners or volatile solvents, such as 
thinner, on or around the printer. These can damage the printer.

• While cleaning the inside of the printer, be careful not to touch 
the transfer roller (located underneath the toner cartridge). Oil 
from your fingers can cause print quality problems.

CAUTIONS: Cleaning the cabinet of the printer with surfactants 
containing large amounts of alcohol, solvent or other strong 
substances can discolor or crack the cabinet .

Cleaning the Outside

Clean the cabinet of the printer with a soft, lint-free cloth, You 
can dampen the cloth slightly with water, but be careful not to 
be let any water drip onto the printer or inside of it.

Cleaning the Inside

During the printing process, paper, toner, and dust particles can 
accumulate inside the printer. This buildup can cause print 
quality problems, such as toner specks or smearing. Cleaning 
the inside of the printer will eliminate or reduce these problems.

Cleaning inside the printer

1 Turn the printer off and unplug the power cord, then wait 
for the printer to cool.

2 Open the top cover and remove the toner cartridge.
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3 With a dry and lint-free cloth, wipe away any dust and 
spilled toner from the toner cartridge area and the toner 
cartridge cavity.

CAUTION: To prevent damage to the toner cartridge, do not 
expose it to light for more than a few minute. Cover it with a piece 
of paper, if necessary. Also, do not touch the black transfer roller 
inside the printer. 

4 Locate the long strip of glass (LSU) inside the top of the 
cartridge compartment, and gently swab the glass to see if 
dirt turns the white cotton black.

5 Reinsert the toner cartridge and close the cover.

6 Plug in the power cord and turn the printer on.
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Printing a cleaning sheet 

If you are experiencing blurred, faded or smeared printouts, you 
can clear the problem by printing a cleaning sheet, provided by 
your printer. You can print:

• OPC Cleaning sheet: cleans the OPC drum of the toner 
cartridge.

• Fuser Cleaning sheet: cleans the fuser unit inside the printer. 

This process will produce a page with toner debris, which should 
be discarded.

1 Ensure that the printer is turned on and in ready mode with 
paper loaded in the tray.

2 Press the Menu button ( ) on the control panel until you 
see “Setup” on the bottom line of the display.

3 Press the Enter button ( ) to access the menu.

4 Press the scroll button (  or ) until “Maintenance” 
displays on the bottom line and press the Enter button 
( ).

5 Press the scroll button (  or ) to select the required 
option, “OPC Cleaning” or “Fuser Cleaning.”

6 Press the Enter button ( ).

Your printer automatically picks up a sheet of paper from 
the tray and prints out a cleaning sheet with dust or toner 
particles on it.
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Consumables and Replacement 
Parts

From time to time, you will need to replace the toner cartridge, 
roller, and fuser unit to maintain top performance and avoid 
print quality problems and paper feed problems resulting from 
worn parts.

The following items should be replaced after you have printed a 
specified number of pages. See the table below.

To purchase the consumables and replacement parts, contact 
your Samsung dealer or the retailer where you bought your 
machine. We strongly recommend that items be installed by a 
trained service professional, except for the toner cartridge.

Items Yield (Average)

Regi. roller 100,000

Transfer roller 100,000

Pick-up roller 100,000

Fuser unit 100,000

Retard roller 100,000
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This chapter provides helpful information for what to do if 
you encounter an error while using your printer. 

This chapter includes:

• Troubleshooting Checklist

• Solving General Printing Problems

• Clearing Paper Jams

• Solving Print Quality Problems

• Understanding Display Messages

• Common Windows Problems

• Common Macintosh Problems

• Troubleshooting PS Errors

• Common Linux Problems

• Common DOS Problem

SOLVING PROBLEMS 
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Troubleshooting Checklist

If the printer is not working properly, consult the following 
checklist. If the printer does not pass a step, follow the 
corresponding troubleshooting suggestions.

Check Solution

Make sure that the 
On-Line/Continue 
button on the control panel 
is on in green and “Ready” 
is shown on the display. 

• If the button backlight are off, check the power cord 
connection. Check the power switch. Check the power 
source by plugging into another outlet.

• If the button backlight are on in orange, check the 
display message and go to “Understanding Display 
Messages” on page 7.20. 

Print a demo page to verify 
that the printer is feeding 
paper correctly. See 
page 2.14.

• If a demo page does not print, check the paper supply in 
the paper tray.

• If the paper jams in the printer, go to “Clearing Paper 
Jams” on page 7.7.

• If an error message appears on the display, go to 
“Understanding Display Messages” on page 7.20.

Check the demo page to see 
if it is printed correctly.

If there is a print quality problem, go to “Solving Print 
Quality Problems” on page 7.15. 

Print a short document 
from a software application 
to verify that the computer 
and printer are connected 
and are communicating 
correctly.

• If the page does not print, check the cable connection 
between the printer and the computer. 

• Check the print queue or print spooler to see if the 
printer has been paused.

• Check the software application to ensure that you are 
using the proper printer driver and communication port. 
If the page is interrupted during printing, go to “Solving 
General Printing Problems” on page 7.3.

If completing the checklist 
does not resolve the printer 
problem, check the 
following troubleshooting 
sections.

• “Solving General Printing Problems” on page 7.3.
• “Understanding Display Messages” on page 7.20.
• “Common Windows Problems” on page 7.22.
• “Common Macintosh Problems” on page 7.23.
• “Troubleshooting PS Errors” on page 7.24.
• “Common Linux Problems” on page 7.25.
• “Common DOS Problem” on page 7.27.
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Solving General Printing Problems

For problems with the operation of your printer, refer to the table 
for suggested solutions.

Problem Possible Cause Solution

The printer does 
not print.

The printer is not 
receiving power.

Check the power cord connections. Check 
the power switch and the power source.

The printer is not 
selected as the default 
printer.

Select Samsung ML-2550 Series or 
Samsung ML-2550 Series PS as your 
default printer.

Check the printer for 
the following:

• The printer cover is not closed.
• Paper is jammed.
• No paper is loaded.
• The toner cartridge is not installed.

If a printer system error occurs, contact 
your service representative.

The printer may be in 
manual feed mode and 
out of paper.

Check the display message, add paper to 
the Multi-Purpose Tray and press the 
On-Line/Continue button on the printer’s 
control panel.

The connection cable 
between the computer 
and the printer is not 
connected properly.

Disconnect the printer cable and reconnect 
it.

The connection cable 
between the computer 
and the printer is 
defective.

If possible, attach the cable to another 
computer that is working properly and print 
a job. You can also try using a different 
printer cable.

The port setting is 
incorrect.

Check the Windows printer setting to make 
sure that the print job is sent to the correct 
port, for example, LPT1. If the computer 
has more than one port, make sure that the 
printer is attached to the correct one.

The printer may be 
configured incorrectly. 

Check the printer properties to ensure that 
all of the print settings are correct. 
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The printer 
does not print. 
(continued)

The printer driver may 
be incorrectly installed.

Reinstall the printer driver; see page 2.19. 
Try printing a demo page.

The printer is 
malfunctioning.

Check the display message on the control 
panel to determine if the printer is 
indicating a system error.

Printer selects 
print materials 
from the wrong 
paper source.

The paper source 
selection in the printer 
properties may be 
incorrect.

For many software applications, the paper 
source selection is found under the Paper 
tab within the printer properties. Select the 
correct paper source. See page 5.7.

Paper does not 
feed into the 
printer.

Paper has not been 
loaded correctly.

Remove paper from the tray and reload it 
correctly.

There is too much 
paper in the paper tray.

Remove excess paper from the tray.

The paper is too thick. Use only paper that meets the specifications 
required by the printer.

Print job is 
extremely slow.

The job may be very 
complex.

Reduce the complexity of the page or try 
adjusting the print quality settings.

The maximum print speed of your printer is 20 
PPM (pages per minute) for A4-sized paper or 
21 PPM for Letter-sized paper.

If using Windows 9x/
Me, the Spooling 
Setting may be set 
incorrectly. 

From the Start menu, choose Settings and 
Printers. Right-click the Samsung 
ML-2550 Series printer icon, choose 
Properties, click the Details tab, and then 
choose the Spool Settings button. Select 
the desired spool setting.

The computer may 
have insufficient 
random-access 
memory (RAM). 

Install more memory in your printer. See 
“Installing Memory and PostScript DIMMs” 
on page F.3.

Problem Possible Cause Solution
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Half the page is 
blank.

The page layout is too 
complex.

Simplify the page layout and remove any 
unnecessary graphics from the document. 
Install more memory in your printer. See 
“Installing Memory and PostScript DIMMs” 
on page F.3.

The page orientation 
setting may be 
incorrect.

Change the page orientation in your 
application. See page 5.3.

The paper size and the 
paper size settings do 
not match.

Ensure that the paper size in the printer 
driver settings matches the paper in the 
tray.

The paper 
keeps jamming.

There is too much 
paper in the paper tray.

Remove excess paper from the tray. 

If printing on special materials, use the 
Multi-Purpose Tray.

An incorrect type of 
paper is being used.

Use only paper that meets the specifications 
required by the printer.

An incorrect output 
method is being used.

Special print materials, such as thick paper, 
should not be printed using the top output 
tray (face-down). Use the rear output tray 
(face-up) instead.

There may be debris 
inside the machine.

Open the top cover and remove the debris.

The printer 
prints, but the 
text is wrong, 
garbled, or 
incomplete.

The printer cable is 
loose or defective.

Disconnect the printer cable and reconnect. 
Try a print job that you have already printed 
successfully. If possible, attach the cable 
and printer to another computer and try a 
print job that you know works. Finally, try a 
new printer cable.

The wrong printer 
driver was selected.

Check the application’s printer selection 
menu to ensure that your printer is 
selected.

The software 
application is 
malfunctioning.

Try printing a job from another application.

The operating system is 
malfunctioning.

If printing from Windows (any version), exit 
to a DOS prompt and verify functionality 
with the following command: At a C:\ 
prompt, type Dir LPT1, and press Enter. 
(This assumes you are connected to LPT1.) 
Exit Windows and reboot the computer. 
Turn the printer off and then back on again.

Problem Possible Cause Solution
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ATTENTION: 
If you have any printing problem after your printer prints about 100,000 pages, you 
must contact the customer service to replace the transfer roller.

Pages print, but 
are blank.

The toner cartridge is 
defective or out of 
toner.

Redistribute the toner. if necessary. See 
page 6.4.

If necessary, replace the toner cartridge.

The file may have blank 
pages.

Check the file to ensure that it does not 
contain blank pages.

Some parts, such as 
the controller or the 
board, may be 
defective.

Contact a service representative.

The illustrations 
print incorrectly 
in Adobe 
Illustrator.

The setting in the 
software application is 
wrong.

Print the document with selecting 
Download as Bit Image in the Advanced 
Options window of the graphic properties.

Problem Possible Cause Solution
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Clearing Paper Jams

When a paper jam occurs, the display on the control panel 
shows the message indicating the corresponding location of the 
paper jam. Refer to the table below to locate the paper jam and 
to clear it. 

In the Paper Feed Area

1 Slide out the Tray1 to expose the jammed paper.

2 Remove any misfed paper by pulling it out by the visible 
edge from the tray. Make sure that all of the paper is 
properly aligned in the tray.

Message Location of Jam Go to...

Jam0 In the paper feed area below

Jam1 Around the toner cartridge page 7.10

Jam2 In the paper exit area page 7.12

Jam Duplex1/2 In the duplex area page 7.13
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NOTE: If the jammed paper is not invisible or if there is resistance 
when you pull the paper, remove the tray from the printer and 
carefully pull the jammed paper free from the printer.

3 Slide the tray back into the printer. 

4 Open and close the top cover to resume printing. 

In the Optional Tray2

1 Pull the optional Tray2 out of the printer.

2 If you see the jammed paper, remove the paper from the 
tray.
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3 If you cannot find the jammed paper in the Tray2, pull the 
Tray1 half way out of the printer, and remove the paper.

4 Slide the trays back into the printer. Open and close the top 
cover. Printing can be resumed.

In the Multi-Purpose Tray

1 Open the Multi-Purpose Tray.

2 Carefully remove the jammed paper from the tray.

3 Open and close the top cover. Printing can be resumed.
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Around the Toner Cartridge

1 Open and close the top cover, and the jammed paper is 
automatically exits the printer.

If not, continue to Step 2.

2 Open the top cover and remove the toner cartridge.

CAUTION: To prevent damage to the toner cartridge, do not 
expose it to light for more than a few minutes. Place a piece of 
paper over the top of the toner cartridge to shield it while it is out 
of the printer.

3 Carefully lift up the guide feed.
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4 Gently pull the jammed paper towards you to remove it 
from the printer.

If the jammed paper is not visible or there is resistance 
when you pull the paper, go to “In the Paper Exit Area” on 
page 7.12.

5 Flip down the guide feed and reinstall the toner cartridge.

NOTE: If the toner cartridge is difficult to reinstall, make sure that 
the guide feed has been flipped back down into position.

6 Close the top cover. Printing can be resumed.
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In the Paper Exit Area

1 If a long portion of the paper is visible, pull it straight out. If 
not, continue to Step 2.

2 Open the rear output tray.

3 Loosen the paper if it is caught in the feed rollers. Then 
gently pull the paper out.

4 Close the rear output tray.

5 Open and close the top cover. Printing can be resumed. 
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In the Duplex Area

Jam Duplex1

1 Open the rear output tray.

2 Remove the jammed paper.

3 Close the rear output cover. 

4 Open and close the top cover. Printing can be resumed. 

Jam Duplex2

1 Pull the paper tray out of the printer.

2 Pull down the metal plate inside of the printer.

CAUTION: Pulling the plate may do you an injury. Use the lever 
on the left.
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3 Remove the jammed paper.

4 Slide the tray back into the printer. 

5 Open and close the top cover. Printing can be resumed. 

Tips for Avoiding Paper Jams

By selecting the correct paper types, most paper jams can be 
avoided. If a paper jam occurs, follow the steps outlined in 
“Clearing Paper Jams” on page 7.7. 

• Follow the procedures in “Loading Paper” on page 2.6. Ensure 
that the adjustable guides are positioned correctly.

• Do not overload the paper tray. Ensure that the paper is below 
the paper limit mark on the inside wall of the tray.

• Do not remove the paper from the tray while printing.

• Flex, fan and straighten the paper before loading. 

• Do not use creased, damp or highly curled paper.

• Do not mix paper types in the tray.

• Use only recommended print materials. See “Paper 
Specifications” on page G.3.

• Ensure that the recommended print side is facing down when 
loading paper in the tray and facing up in the Multi-Purpose 
Tray.
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Solving Print Quality Problems

The dirty inside of the printer or improper paper loading may 
reduce the print quality. See the table below to troubleshoot the 
problem. 

Problem Solution

Light or faded 
print

If a vertical white streak or faded area appears on the page:
• The toner supply is low. You may be able to temporarily 

extend the toner cartridge life. See “Redistributing Toner” on 
page 6.4. If this does not improve the print quality, install a 
new toner cartridge.

• The paper may not meet paper specifications (for example, 
the paper is too moist or too rough). See “Paper 
Specifications” on page G.3.

• If the entire page is light, the print resolution setting is too 
light or Toner Save Mode is on. Adjust the print resolution 
and Toner Save Mode in the printer properties. See 
page 5.25 and page 5.9 respectively.

• A combination of faded or smeared defects may indicate that 
the toner cartridge needs cleaning. See “Cleaning the Inside” 
on page 6.7.

• The surface of LSU may be dirty. Clean the LSU. See 
“Cleaning the Inside” on page 6.7.

Toner specs • The paper may not meet specifications (for example, the 
paper is too moist or too rough). See “Paper Specifications” 
on page G.3.

• The transfer roller may be dirty. See “Cleaning the Inside” on 
page 6.7.

• The paper path may need cleaning. See “Cleaning the Inside” 
on page 6.7.

AaAaBbBbCcCc
AaAaBbBbCcCc
AaAaBbBbCcCc
AaAaBbBbCcCc
AaAaBbBbCcCc

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc
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Dropouts If faded areas, generally rounded, occur randomly on the page:
• A single sheet of paper may be defective. Try reprinting the 

job.
• The moisture content of the paper is uneven or the paper has 

moist spots on its surface. Try a different brand of paper. See 
“Paper Specifications” on page G.3.

• The paper lot is bad. The manufacturing processes can cause 
some areas to reject toner. Try a different kind or brand of 
paper.

• The toner cartridge may be defective. See “Vertical 
repetitive defects” on the next page.

•  If these steps do not correct the problems, contact a service 
representative.

Vertical lines If black vertical streaks appear on the page:
• The drum inside the toner cartridge has probably been 

scratched. Install a new toner cartridge. 

Gray background If the amount of background shading becomes unacceptable, 
the procedures below may fix the problem.
• Change to a lighter weight pages. See “Paper Specifications” 

on page G.3.
• Check the printer’s environment; very dry (low humidity) or 

high humidity (higher than 80% RH) conditions can increase 
the amount of background shading.

• Remove the old toner cartridge and install a new one. See 
“Installing the Toner Cartridge” on page 2.4.

Toner smear • Clean the inside of the printer. See “Cleaning the Inside” on 
page 6.7.

• Check the paper type and quality. See “Paper Specifications” 
on page G.3.

• Remove the toner cartridge and install a new one. See 
“Installing the Toner Cartridge” on page 2.4.

Problem Solution

AaBbCc
AaBbCc
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AaBbCcAaBbCc

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc



SOLVING PROBLEMS 7.17

7

Vertical repetitive 
defects

If marks repeatedly appear on the printed side of the page at 
even intervals:
• The toner cartridge may be damaged. If a repetitive mark 

occurs on the page, print a cleaning sheet several times to 
clean the cartridge; see page 6.9. After the printout, if you 
still have the same problems, install a new toner cartridge. 
See “Installing the Toner Cartridge” on page 2.4.

• Parts of the printer may have toner on them. If the defects 
occur on the back of the page, the problem will likely correct 
itself after a few more pages.

• The fusing assembly may be damaged. Contact a service 
representative.

Background 
scatter

Background scatter results from bits of toner distributed on the 
printed page. 
• The paper may be too damp. Try printing with a different 

batch of paper. Do not open packages of paper until 
necessary so that the paper does not absorb too much 
moisture.

• If background scatter occurs on an envelope, change the 
printing layout to avoid printing over areas that have 
overlapping seams on the reverse side. Printing on seams 
can cause problems.

• If background scatter covers the entire surface area of a 
printed page, adjust the print resolution through your 
software application or the printer properties.

Misformed 
characters

• If characters are improperly formed and producing hollow 
images, the paper stock may be too slick. Try a different 
paper. See “Paper Specifications” on page G.3.

• If characters are improperly formed and producing a wavy 
effect, the scanner unit may need service. Verify that it also 
occurs on a demo page (see page 2.14). For service, contact 
a service representative.

Page skew • Check the paper type and quality. See “Paper Specifications” 
on page G.3.

• Ensure that the paper or other material is loaded correctly 
and the guides are not too tight or too loose against the 
paper stack.

Problem Solution

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc

A

AaBbCcAaBbCcAaBbCcAaBbCcAaBbCc
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Curl or wave • Check the paper type and quality. Both high temperature and 
humidity can cause paper curl. See “Paper Specifications” on 
page G.3.

• Turn over the stack of paper in the tray. Also try rotating the 
paper 180° in the tray.

• Try printing to the face up output slot.

Wrinkles or 
creases

Ensure that the paper is loaded properly.
• Check the paper type and quality. See “Paper Specifications” 

on page G.3.
• Open the rear cover and try printing to the rear output tray 

(face-up).
• Turn over the stack of paper in the paper tray. Also try 

rotating the paper 180° in the tray.

Back of printouts 
are dirty

• The transfer roller may be dirty. “Cleaning the Inside” on 
page 6.7.

• Check for leaking toner. Clean the inside of the printer. 

Black pages • The toner cartridge may not be installed properly. Remove 
the cartridge and reinsert.

• The toner cartridge may be defective and need replacing. 
Install a new toner cartridge.

• The printer may require repair. Contact a service 
representative.

Problem Solution

A
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Loose toner Clean the inside of the printer. 
• Check the paper type and quality. See “Paper Specifications” 

on page G.3.
• Install a new toner cartridge. See “Installing the Toner 

Cartridge” on page 2.4.
• If the problem persists, the printer may require repair. 

Contact a service representative.

Character Voids Character voids are white areas within the parts of characters 
that should be solid black:
• If you are using transparencies, try another type of 

transparency. Because of the composition of the 
transparency, some character voids are normal. 

• You may be printing on the wrong surface on the paper. 
Remove the paper and turn it around. 

• The paper may not meet paper specifications. See “Paper 
Specifications” on page G.3.

Horizontal stripes If horizontally aligned black streaks or smears appear:
• The toner cartridge may be installed improperly. Remove the 

cartridge and reinsert.
• The toner cartridge may be defective. Install a new toner 

cartridge. See “Installing the Toner Cartridge” on page 2.4.
• If the problem persists, the printer may require repair. 

Contact a service representative.

Problem Solution

A
AaBbCc
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Understanding Display Messages

The display on the front panel shows the messages to indicate 
the printer’s status or errors. Refer to the tables below to 
understand the message’s meaning and clear the problem if 
necessary. Messages and their meanings are listed in 
alphabetical order.

NOTE: When you call for service, it is very convenient to tell the 
specified message.

Message Status Do this...

Cover Open/No
Toner Cartridge

A cover is open/There is 
no toner cartridge 
installed in your printer

Close the top cover firmly/Install 
the cartridge.

Invalid Toner Your toner cartridge is 
not for your printer.

Install a Samsung-approved 
toner cartridge, designed for 
your printer.

Jam 0 A paper jam occurs in 
the paper feed area.

Remove the jammed paper from 
the tray in use, referring to 
page 7.7.

Jam 1 A paper jam occurs 
around the toner 
cartridge.

Remove the jammed paper from 
the printer, referring to 
page 7.10.

Jam 2 A paper jam occurs in 
the paper exit area.

Remove the jammed paper from 
the output tray, referring to 
page 7.12.

JAM Duplex1/2 A paper jam occurs 
while printing on both 
sides of paper.

Remove the jammed paper from 
the printer, referring to 
page 7.13.

Load Manual
Press Cont Key

The Multi-Purpose Tray 
is empty in manual feed 
mode.

Load a sheet of print material 
and press the On-Line/
Continue button. You need to 
press the button each page to be 
printed.

Memory Overflow The printer does not 
have enough memory to 
print the current job.

The job will be automatically 
cleared and the printer will 
return to ready mode.
• Expand the memory in your 

printer. See“Installing Memory 
and PostScript DIMMs” on 
page F.3.
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Page Too Complex Too complicated data 
was sent to the printer.

Simplify the page layout and 
remove unnecessary graphics 
from your document.

If the message persists, expand 
the memory in your printer. See 
“Installing Memory and 
PostScript DIMMs” on page F.3.

Paper Empty
[Size]In[Tray]

The displayed tray is 
empty.

Load the corresponding size of 
paper into the tray.

Ready
Low Toner

The toner cartridge in 
your printer is nearly 
empty.

Redistribute the toner, referring 
to page 6.4.

Serial Error

* may be shown only if you 
installed the optional serial 
interface card.

The printer detects a 
serial interface error.

Set the baud rate the same as 
the setting on your computer.

Ready 
Replace Cart

The life of some parts on 
the toner cartridge ends

The overflow of the waste toner 
contaminates the inside of the 
machine.

Regardless of the remaining 
toner, this is warning message 
showing that  The toner cartridge 
replacement is needed as the 
parts life there of is exhausted. the 
toner cartridge is at the end of its 
life and the print quality lowers, 
You need to replace 
the cartridge to new one. to con-
tinue printing, press On-Line/
Continue each time you print a 
page.

Wait Image The firmware 
programme in the 
printer has been 
damaged.

You need to download the 
programme to the printer again. 
Contact your local Samsung 
dealer.

Message Status Do this...
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Common Windows Problems

NOTE: Refer to Microsoft Windows 9x/Me/NT 4.0/2000/XP User’s Guide that came with 
your PC for further information on Windows error messages.

Problem Possible Cause and Solution

“File in Use” message 
appears during installation.

Exit all software applications. Remove all software from the 
StartUp Group, then restart Windows. Reinstall the printer 
driver.

“Error Writing to LPTx” 
message appears.

• Ensure that the cables are connected correctly, the 
printer is on.

• If bi-directional communication is not turned on in the 
driver, it will also cause this message.

“General Protection Fault”, 
“Exception OE”, “Spool32”, 
or “Illegal Operation” 
messages appear.

Close all other applications, reboot Windows and try 
printing again.
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Common Macintosh Problems

Problems in the Chooser

Printing Errors

Problem Possible Cause and Solution

The printer driver icon 
does not appear in 
Chooser.

Software is not installed correctly.
• The LaserWriter driver should be present as a part of the 

Macintosh OS. Make sure that the LaserWriter driver is in the 
Extensions folder within the Systems folder. If not, install 
the LaserWriter driver component from the Macintosh OS CD.

• Make sure that you are using a high-quality cable.
• Make sure that the printer is on the correct network. Select 

Network or AppleTalk Control Panel from Control 
Panels in the Apple menu and then choose the correct 
network.

The printer name does 
not appear in the 
Select a PostScript 
Printer box in the 
Chooser.

• Make sure that the cables are connected correctly and the 
printer is turned on. 

• Check if “Ready” appears on the display of the control panel. 
If not, press the On-Line/Continue button to switch your 
printer to on-line.

• Make sure that the correct printer driver has been selected in 
Chooser.

• If the printer resides on a network with multiple zones, make 
sure that the correct zone is selected in the AppleTalk Zones 
box in Chooser.

• Make sure that AppleTalk is on; the button next to Active is 
selected in Chooser. You may need to restart the computer to 
activate the change.

Problem Possible Cause and Solution

You cannot use the 
computer while the 
printer is printing.

Background Printing has not been selected.
• For LaserWriter 8.3, turn Background Printing on in the 

Chooser. Status messages will now be redirected to the Print 
Monitor allowing you to continue working while the computer 
is processing data to be sent to the printer.

• For LaserWriter 8.4 or higher, turn Background Printing on 
at the Print window.




